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ВВЕДЕНИЕ 

Данные о дисциплине: дисциплина «Компьютерная графика» предназначена для 

студентов по направлению: специальности «Прикладная информатика». 

Пререквизиты: Изучение дисциплины "Компьютерная графика" базируется на знаниях 

изученных дисциплин: «Информатика», «Архитектура ЭВМ и ВС». 

       Постреквизиты: Создание рекламных макетов для полиграфии и web разработка 

дизайн-проектов, рекламных материалов. 

Дисциплина «Компьютерная графика» входит в вариативную часть. В соответствие 

с учебным планом по направлению подготовки «Прикладная информатика». Данная 

дисциплина изучается на 3-м курсе в течение семестра. 

Дисциплина «Компьютерная графика» занимает одно из наиболее важных мест в 

образовательном процессе данного направления. Представленный материал соответствует 

образовательной программе по направлению, содержит в себе лекции, практические 

задания, упражнения, вопросы для повторения и самостоятельной работы, 

мультимедийные материалы, тестовые задания, экзаменационные вопросы. Все разделы 

последовательны и тесно связаны друг с другом. 

Цели и задачи изучения дисциплины 

Целью данной дисциплины является освоение средств обработки и редактирования 

компьютерной графики. В результате изучения дисциплины студенты должны иметь 

представление: о средствах и методах обработки и редактирования компьютерной графики; 

о проблемах и направлениях развития графического дизайна; об основных методах и 

средствах создания и редактирования графических файлов; об использовании графических 

программных пакетов.   

В результате изучения дисциплины студент должен знать: 

В результате освоения дисциплины обучающийся должен знать: 

- принципы формирования цифрового изображения; 

- правила обработки и подготовки изображений для публикации в электронных и 

бумажных изданиях; 

- основы композиции, правила построения графических и верстки изданий. 

В результате освоения дисциплины обучающийся должен уметь: 

- создавать и обрабатывать растровые и векторные графические изображения; 

- подготовку макетов к печати. 

Рекомендации по изучению дисциплины 

Для качественного изучения дисциплины рекомендуется использовать в ходе 

учебного процесса интерактивные доски, электронные учебные пособия по данной 

дисциплине, видеокурсы и Интернет-ресурсы. 

Компетенции, формируемые в результате изучения дисциплины 

Процесс изучения дисциплины направлен на формирование следующих 

компетенций: 

Профессиональные компетенции, включающие в себя способность: 

ПК-3 - осуществлять подготовку оборудования к работе. 

ПК-5 - контролировать работу компьютерных, периферийных устройств и теле 

коммуникационных систем, обеспечивать их правильную эксплуатацию. 

ПК-8 - проводить отладку и тестирование программного обеспечения 

отраслевой направленности. 
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Структура и трудоемкость дисциплины 

Вид работы, семестр 

Трудоемкость, час 

очное обучение  
заочное 

обучение  

№ семестров 5  

Кредит   3  

Общая трудоемкость  50  

Аудиторная работа  36  

Лекции  22  

Практические занятия/семинары  14  

Лабораторные работы   

Самостоятельная работа  24  

Курсовые работы или проекты (при наличии)    

Рефераты (при наличии)    

Внеаудиторные самостоятельные работы (расчетно-

графические задания, типовые расчеты, и т.д.) 
 

 

Самоподготовка (самостоятельное изучение 

теоретического материала, подготовка к прак-

тическим занятиям, текущему контролю и т.д.) 

 

 

Виды текущего контроля (перечислить)    

Вид итогового контроля  Экзамен   

 

 

  



 4 

ПРОГРАММА КУРСА 

ТЕМАТИЧЕСКИЙ ПЛАН ДИСЦИПЛИНЫ 

№ 
Тематика лекционных занятий Кол-во 

часов 

Наименование тем 

практических занятий 

Кол-во 

часов 

СРС 

1 

Форматы графических файлов. 

Преобразование файлов из 

одного формата в другой. 

Векторные форматы 

Растровые форматы 

Сохранение изображений в 

стандартных и собственных 

форматах графических редакторов 

Преобразование форматов 

графических файлов 

 

 

 

 

6 

 

Вращение, 

комбинирование объектов 

CorelDraw 

2 6 

2 

Понятие цвета. Цветовые 

модели. 

Понятие цвета. Способы описания 

цвета 

Цветовая модель RGB 

Цветовая модель CMYK 

Цветоделение при печати 

 

 

 

 

4 

 

Отражение, копирование и 

удаление объектов.  

Создание и редактирование 

контуров в Corel Draw.  

Создание рисунков и 

кривых в Corel Draw. 

Создание рисунка 

«Яблоко» 

4 6 

 Модуль-1 10  6  

3 

Фрактальная графика 

Понятие фрактала и история 

появления фрактальной графики. 

Понятие размерности и ее расчет. 

Геометрические фракталы 

Алгебраические фракталы 

 

 

 

 

4 

 

 

Создание и редактирование 

контуров в Corel Draw. 

Создать объекты по 

образцу 

Упорядочивание, 

группирование, 

соединение, объединение, 

объектов. 

Исключение, пересечение 

объектов.  

Выравнивание объектов. 

4 6 

4 

Трехмерная графика 

История трехмерной графики 

Сферы применения трёхмерной 

графики, примеры 3D‑объектов 

Особенности работы с 

3D‑графикой 

Этапы создания трехмерного 

проекта 

 

 

 

8 

Освоение приемов работы 

с многослойными 

изображениями в 

программе Adobe 

Photoshop (создание 

коллажа). 

Освоение приемов 

художественной обработки 

фотографий в программе 

Adobe Photoshop. 

Эффекты имитации Adobe 

Photoshop 

4 6 

 Модуль-2 12  8 12 

 Всего 22  14 24 
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КРАТКИЙ КУРС ЛЕКЦИЙ 

 

Тема №1 Форматы графических файлов. Преобразование файлов из одного формата 

в другой. 

Векторные форматы 

Растровые форматы 

В компьютерной графике применяют, по меньшей мере, три десятка форматов 

файлов для хранения изображений. Но лишь часть из них применяется в подавляющем 

большинстве программ. Как правило, несовместимые форматы имеют файлы растровых, 

векторных, трехмерных изображений, хотя существуют форматы, позволяющие хранить 

данные разных классов. Многие приложения ориентированы на собственные 

«специфические» форматы, перенос их файлов в другие программы вынуждает 

использовать специальные фильтры или экспортировать изображения в «стандартный» 

формат. 

Сохранение изображений в стандартных и собственных форматах графических 

редакторов 

Преобразование форматов графических файлов 

 

Тема №2 Понятие цвета. Цветовые модели. 

Понятие цвета. Способы описания цвета 

Цвет – чрезвычайно сложная проблема, как для физики, так и для физиологии, т.к. он имеет 

как психофизиологическую, так и физическую природу. Восприятие цвета зависит от 

физических свойств света, т. е. электромагнитной энергии, от его взаимодействия с 

физическими веществами, а также от их интерпретации зрительной системой человека. 

Другими словами, цвет предмета зависит не только от самого предмета, но также и от 

источника света, освещающего предмет, и от системы человеческого видения. Более того, 

одни предметы отражают свет (доска, бумага), а другие его пропускают (стекло, вода). Если 

поверхность, которая отражает только синий свет, освещается красным светом, она будет 

казаться черной. Аналогично, если источник зеленого света рассматривать через стекло, 

пропускающее только красный свет, он тоже покажется черным. 

Цветовая модель RGB 

Это одна из наиболее распространенных и часто используемых моделей. Она 

применяется в приборах, излучающих свет, таких, например, как мониторы, прожекторы, 

фильтры и другие подобные устройства. 

Данная цветовая модель базируется на трех основных цветах: Red – красном, Green – 

зеленом и Blue – синем. 

Цветовая модель CMYK 

Это еще одна из наиболее часто используемых цветовых моделей, нашедших широкое 

применение. Она, в отличие от аддитивной RGB, является субтрактивной моделью.  

Модель CMYK (Cyan Magenta Yellow Key, причем Key означает черный цвет) – является 

дальнейшим улучшением модели CMY и уже четырехканальна. Поскольку реальные 

типографские краски имеют примеси, их цвет не совпадает в точности с теоретически 

рассчитанным голубым, желтым и пурпурным. Особенно трудно получить из этих красок 

черный цвет. Поэтому в модели CMYK к триаде добавляют черный цвет. Почему–то в 

названии цветовой модели черный цвет зашифрован как K (от слова Key – ключ). Модель 

CMYK является «эмпирической», в отличие от теоретических моделей CMY и RGB. 

Модель является аппаратно–зависимой.  

Цветоделение при печати 

 

Тема №3 Фрактальная графика 

Понятие фрактала и история появления фрактальной графики. 
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Вы, наверное, часто видели довольно хитроумные картины, на которых непонятно что 

изображено, но все равно необычность их форм завораживает и приковывает внимание. Как 

правило, это хитроумные формы не поддающиеся, казалось бы, какому–либо 

математическому описанию. Вы, к примеру, видели узоры на стекле после мороза или, к 

примеру, хитроумные кляксы, оставленные на листе чернильной ручкой, так вот что–то 

подобное вполне можно записать в виде некоторого алгоритма, а, следовательно, доступно 

объясниться с компьютером. Подобные множества называют фрактальными. Фракталы 

не похожи на привычные нам фигуры, известные из геометрии, и строятся они по 

определенным алгоритмам, а эти алгоритмы с помощью компьютера можно изобразить на 

экране. Вообще, если все слегка упростить, то фракталы – это некое преобразование 

многократно примененное к исходной фигуре.  

Понятие размерности и ее расчет. 

В своей повседневной жизни мы постоянно встречаемся с размерностями. Мы 

прикидываем длину дороги, узнаем площадь квартиры и т.д. Это понятие вполне 

интуитивно ясно и, казалось бы, не требует разъяснения. Линия имеет размерность 1. Это 

означает, что, выбрав точку отсчета, мы можем любую точку на этой линии определить с 

помощью 1 числа – положительного или отрицательного. Причем это касается всех линий 

– окружность, квадрат, парабола и т.д.  

Геометрические фракталы 

Именно с них и начиналась история фракталов. Этот тип фракталов получается путем 

простых геометрических построений. Обычно при построении этих фракталов поступают 

так: берется «затравка» – аксиома – набор отрезков, на основании которых будет строиться 

фрактал. Далее к этой «затравке» применяют набор правил, который преобразует ее в 

какую–либо геометрическую фигуру. Далее к каждой части этой фигуры применяют опять 

тот же набор правил. С каждым шагом фигура будет становиться все сложнее и сложнее, и 

если мы проведем бесконечное количество преобразований – получим геометрический 

фрактал.  

Алгебраические фракталы  

 

Тема №4. Трехмерная графика 

История трехмерной графики 

В начале ХХ века появились первые стереоскопические фотоаппараты, которые имели два 

объектива, расположенных на расстоянии 65 мм друг от друга, что равняется среднему 

расстоянию между зрачками глаз. Такие фотоаппараты давали возможность без проблем 

получать стереоизображения. 

Примерно в то же время была запатентована технология, позволяющая использовать 

стереоскоп для показа трехмерных фильмов. 

В начале 1950 годов в Америке были очень популярны фильмы, для просмотра которых 

использовались поляризованные стереоочки с синими и красными стеклами (рис. 1.3). 

Эффект достигался следующим образом: два изображения проецировались на экран через 

ортогональный поляризационный фильтр, накладываясь друг на друга. В результате 

зритель, надевший очки с такими же фильтрами, видел каждым глазом только тот спектр, 

который проходил через соответствующий фильтр. Таким образом достигался эффект 

стереоскопии. 

Что такое трёхмерная графика 

3D-графика — одна из технологий создания CGI (от англ. Computer-Generated Imagery, 

«изображения, сгенерированные компьютером»). А 3D-моделирование — создание 

трёхмерных объектов при помощи специальных программ. 

3D-объекты используются в веб-дизайне, интерфейсах мобильных приложений, 

виртуальной и дополненной реальности — VR и AR. Персонажи игр и фильмов тоже могут 

быть созданы с применением 3D-технологий. 

Сферы применения трёхмерной графики, примеры 3D‑объектов 
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Элементы трёхмерной графики 

Особенности работы с 3D‑графикой 

Этапы создания трехмерного проекта  

Моделирование 

В трехмерном пространстве 3ds Max не существует никаких предметов. Виртуальный мир 

наполняется разными объектами, которые создает пользователь в 3D-редакторе. Это 

относится к трехмерным персонажам, зданиям, горам, лесам и любым другим вещам 

виртуального мира. Процесс создания трехмерных объектов называется моделированием, а 

сами объекты - моделями. В отличие от рисованного изображения, трехмерную модель 

можно вращать и перемещать в трех измерениях, глядя на нее со всех сторон. 

Анимация 

Анимация подразумевает изменение положения объектов, которые присутствуют в 

трехмерном пространстве, во времени. Например, если требуется сделать анимацию 

падающего карточного домика, то размещение карт в первом кадре будет отличаться от их 

положения во втором и последующих кадрах.  

Съемка 

3D-художник, работающий над анимационным проектом, должен уметь правильно 

подобрать расположение камер, чтобы точка съемки была наиболее удачной, а также 

продумать, как камеры будут перемещаться в процессе анимации. 

Освещение 

Виртуальное пространство, в котором работают 3D-художники, в отличие от реального 

мира, не имеет источников освещения. Чтобы увидеть, что происходит в виртуальном мире, 

его нужно осветить. Для имитации освещения в трехмерной графике используются 

специальные объекты, которые так и называются - источники света. Чтобы освещение 3D-

объектов было похоже на настоящее, приходится учитывать множество факторов: где 

расположен источник света, с какой силой он светит, от каких предметов отражается и т. д. 

Текстурирование 

Объекты, созданные в трехмерном пространстве, на этапе моделирования отличаются друг 

от друга только формой. Чтобы 3D-модель напоминала реальный предмет, недостаточно 

точно повторить его форму, нужно еще и раскрасить ее соответствующим образом. Процесс 

раскраски трехмерных объектов называется текстурированием.  

Визуализация 

Этап визуализации тесно связан с этапом съемки. Как только расставили камеры и 

подобрали их параметры, можно начать снимать виртуальный фильм, то есть 

визуализировать его. Визуализацию трехмерного проекта можно сравнить со съемкой 

видеокамерой, однако готовое видео или статическое изображение в этом случае 

записывается не на кассету, а в файл. Визуализацию также называют рендерингом, или 

просчетом. 
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ТЕМАТИЧЕСКИЙ ПЛАН ПРАКТИЧЕСКИХ ЗАНЯТИЙ 

№ Наименование тем Количество 

часов 

1 Вращение, комбинирование объектов CorelDraw 2 

2 Отражение, копирование и удаление объектов.  

Создание и редактирование контуров в Corel Draw. 

2 

3 Создание рисунков и кривых в Corel Draw. 

Создание рисунка «Яблоко» 

2 

4 Создание и редактирование контуров в Corel Draw. 

Создать объекты по образцу 

2 

5 Упорядочивание, группирование, соединение, объединение, 

объектов. 

Исключение, пересечение объектов.  

Выравнивание объектов. 

2 

6 Освоение приемов работы с многослойными изображениями в 

программе Adobe Photoshop (создание коллажа). 

2 

7 Освоение приемов художественной обработки фотографий в 

программе Adobe Photoshop. 

Эффекты имитации Adobe Photoshop 

2 

 Итого за 5-семестр 14 

 Всего 28 
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Практическая работа №1 

Тема: Вращение, комбинирование объектов. 

Цель: Научиться вращению и комбинированию объектов. 

1. Запустите CorelDraw 

2. Сделайте ориентацию страницы альбомной 

3. На панели инструментов выберите эллипс (в качестве базовой фигуры) 

4. Выберите цвет заливки и цвет контура, на панели свойств инструмента установите 

толщину контура 1мм. 

 
5. Выберите положение центра вращения. Для этого щелкните внутри эллипса, чтобы 

вокруг него появились двойные стрелочки… 

 
6. Подхватите за кружок, который находится в центре эллипса, и перетащите его чуть 

выше. Например, так…  
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7. Создайте копию и поверните ее например, на 150 (c помощью кнопки угол 

поворота  ). У вас должно получиться так… 

 
8. Еще раз вставьте копию и поверните еще на 150 аналогичным образом. Поскольку 

копировать необходимости больше нет (скопированный эллипс находится в буфере 

обмена, поэтому эллипс вставляем и угол поворота увеличиваем каждый раз на 150, 

значит, вводим значение 30 в поле ввода…  ) 

 

 
9. И так далее, Вы будете вставлять, и поворачивать каждый новый эллипс на угол 

больший предыдущего на 150 (150, 300, 450, 600, 750, …. 3450). Вот, что должно 

получиться… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. Скомбинируем полученные объекты. Для этого выделите все объекты, в 

контекстном меню выберите команду Комбинировать.  
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И вот результат… 

Попробуйте самостоятельно нарисовать такие снежинки, изменив базовую фигуру и угол 

поворота… 

 
 

Практическая работа №2 

Тема: Отражение, копирование и удаление объектов. Создание и редактирование контуров 

в Corel Draw. 

Цель: Научиться отражению, копированию и удалению объектов, созданию и 

редактированию контуров в Corel Draw. 

 

Ход выполнения работы 
Разберем работу на примере создания металлической крышки. 

ВЫПОЛНЯЕМОЕ ДЕЙСТВИЕ РЕЗУЛЬТАТ 
1. Рисуем окружность. 

 
2. В панели инструментов выбираем 

инструмент Формы звезд.   
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 В настройках выбираем 24-рехконечную 

звезду. 

 
 

Рисуем. Располагаем ее так, чтобы вершины 

немного выступали за границы окружности.  

 

 
3. Выбираем оба объекта и нажимаем 

Объеденить. 

 
4. Далее рисуем еще две окружности.  

 

 
5. Убираем контур у всех фигур. Самый дальний объект окрашиваем в 70% Black. 

 
Остальные два объекта в цвета, которые вам 

хочется или необходимо. Например так: 

 

 
6. В панели инструментов выбираем 

Интерактивное перетекание.  
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Делаем плавный переход сначала между 

дальним и средним объектом.  

 

 
Затем между средним и ближним объектом.  

 

 
7. Теперь создаем блики. Рисуем два объекта 

произвольной формы, один внизу, другой 

ниже. Раскрашиваем их в белый цвет.  

 

 
8. Затем применяем инструмент 

Интерактивная прозрачность. 

 
 

9. Если хотите, добавьте что-нибудь еще. 
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результат: 

 
 

Практическая работа №3 

Тема: Создание рисунков и кривых в Corel Draw. 

Цель: Научиться создавать и корректировать рисунки в Corel Draw с использованием 

кривых на примере создания «Осколка стекла» и рисунка «Яблока». 

Ход выполнения работы 

Задание 1: создание «Осколка стекла» 

ВЫПОЛНЯЕМОЕ ДЕЙСТВИЕ РЕЗУЛЬТАТ 

1. Рисуем треугольник с помощью 

инструмента Bezier (Кривая Безье) 

 

 
2. Инструментом Pick (Выбор) выделяем 

треугольник и применяем к нему команду 

Effacts – Extrude (Эффекты – Вытянуть) и 

создаём объём осколку. 
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3. Выделяем наш объект (Pick), выбираем 

команду Arrange – Break - Extrude Group Apart 

(Расположение- Разделить группу экструзии). 

Внешне никаких изменений не произойдёт. 

 

 
4. Разгруппируем наш объект полностью. В итоге образуются несколько отдельных фигур. 

5. Раскрашиваем наши детали в разные оттенки 

голубовато-зелёного цвета, группируем и 

отменяем обводку. 

 
6. Далее переносим наш осколок на картинку 

 
7. Выбираем команду Effacts-Lens. В 

открывшемся окне разворачиваем список 

разновидностей линз и устанавливаем Magnify 

(Увеличение). Остальные настройки по своему 

вкусу. Жмём Apply. 

 
Создание рисунка  «Яблоко» 

ВЫПОЛНЯЕМОЕ ДЕЙСТВИЕ РЕЗУЛЬТАТ 
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1. Рисуем окружность. 

 

 
2. Преобразовываем в кривые и с помощью 

инструмента Форма немного корректируем. 

 

 
3. Заливаем Радиальной заливкой, не забудьте 

убрать контур. 

 
4. Рисуем еще две окружности. 

 
Маленькая залита C28M0Y97K0, большая – C9M5Y95K0. 

5. Применяем к ним Интерактивное перетекание, НЕ ЗАБУДЬТЕ УБРАТЬ КОНТУР. 

6. Копируем главную окружность и заливаем 

дубликат Текстурной заливкой. 
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7.Накладываем его (дубликат) и применяем к 

нему радиальную Интерактивную 

прозрачность. 

 
Так мы пытались добиться реалистичности шкурки. 

8. Делаем палочку. Выбираем инструмент 

Живопись.  

 
 

И применяем такие настройки: 
 

 

9. Рисуем палочку, заливаем. 

 
10. Рисуем несколько произвольных фигур – 

блики. Заливаем их белым цветом, убираем 

контур. 

 

 
12. Применяем к ним Интерактивную 

прозрачность, делая их чуть видимыми. 
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13. В конце добавляем тень и можно 

пририсовать листик. 

 

 
 

Практическая работа №4 

Тема: Создание и редактирование контуров в Corel Draw. 

Цель: Научиться создавать и корректировать контуры в Corel Draw на примере объемных 

изображений чаши, бокала. 

Ход выполнения работы 

ВЫПОЛНЯЕМОЕ ДЕЙСТВИЕ РЕЗУЛЬТАТ 

В новом документе рисуем эллипс 

 
Заливаем его коническим градиентом 
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Настройки оставляем пока без изменения. 

Убираем обводку (щелкаем правой кнопкой 

мыши на перечеркнутом квадратике) 

Теперь подумаем, что мы хотим получить в 

итоге. Давайте начнем с чего попроще, 

например, с вазы под фрукты. 

Делаем копию эллипса, сдвигаем ее вниз, 

немного уменьшаем размер 

 

 
Делаем еще одну копию овала, размещаем ее 

еще ниже и размер будет самый маленький из 

всех, потом еще одна копия, но размером 

больше, чем предпоследняя. Вот так 

 

 
Теперь делаем интерактивное перетекание 

между овалами. Количество шагов 

перетекания ставим 30-40 

 

 
Получаем 
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Делаем копию верхнего эллипса, чуть 

уменьшаем размер, заливаем линейным 

градиентом 

 

 
Поработаем с заливками и получим чашу 

представленную на примере: 

 
Задания для самостоятельной работы: 

Создайте следующие объекты по образцу: 
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Практическая работа №5 

Тема: Упорядочивание, группирование, соединение, объединение, исключение, 

пересечение объектов. Выравнивание объектов. 

Цель: Научиться работе с объектами в CorelDRAW (упорядочиванию, группировке, 

соединению, объединению, исключению, пересечению, выравниванию объектов) на 

примере рисования грозди винограда. 

Ход выполнения работы 

Задание 1: Рисование грозди винограда в CorelDRAW. 

ВЫПОЛНЯЕМОЕ ДЕЙСТВИЕ РЕЗУЛЬТАТ 

Образец   возможный вариант  

1. Рисуем виноградинки. Элипс, копируем 2 

раза, придаём копиям различные оттенки.  

 

 
2. Применяем эффект перетекания со 

значением по желанию. 
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3. Рисуем блик белого цвета и применяем к 

нему тот же эффект перетекания. 

 

         
4. Многократно копируем нашу ягодку, меняем 

размеры, разворачиваем. По желанию рисуем 

блики внизу. Под большим увеличением 

можно менять окраску для нижнего элепса, 

создавая разные оттенки для виноградинок в 

грозди. 

 
5. Рисуем листик. Моделируем зазубринки. 

Два раза дублируем, уменьшаем копии, 

придаём оттенки. И применяем Перетекание. 

Поверх готового листика инструментом 

Artistic Media Tool рисуем прожилочки и 

раскрашиваем их в светло-зелёный цвет. 
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6. Тем же инструментом создаём черенок и 

лозу.  

 

 
7. Затем жмём Ctrl+K, удаляем стержень 

(черная полосочка внутри) и раскрашиваем 

наши закорючки градиентом. Ставим обводку 

более тёмного цвета. 
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8. Компонуем наши детали, дублируем листик и рисуем солнышко, но можно и без него. 

 
 

Практическая работа №6 

Тема: Освоение приемов работы с многослойными изображениями в программе 

Adobe Photoshop (создание коллажа). 

Цель: работы: знакомство с основными принципами работы с многослойными 

изображениями в программе Photoshop, получение практических навыков по созданию 

коллажа. 

Исходные изображения: 

   
1. Создание фона 
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File>New (Файл>Создать) → в открывающемся окне New (Новый) основные 

атрибуты будущего изображения: размер холста 432*289 пикселей (pixels), цветовая модель 

(Mode) – RGB, 

Цвет фона R 160, G 243, B 244 (бледно голубой) 

Gradient (Градиент) ) → Linear Gradient (Линейная градиентная заливка). ) → 

Проведим курсором мыши по холсту сверху вниз. 

2. Работа с фильтрами 

 
Filter>Render>Clouds (Фильтр>Визуализация>Облака). 

Filter>Render (Фильтр>Визуализация) → новый фильтр Lighting Effects (Эффекты 

освещения) → В качестве источника света (Солнца) вариант Spotlight (Прожектор) 

3. Монтаж слоев. Добавление слоя с изображением рыбака, птицы, рыбы 
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Открытие файла Fisherman.psd. → Edit>Copy (Правка>Копирование) и Edit>Paste 

(Правка>Вставить). →. Вместе с рыбаком в изображение скопируется не нужный фон. → 

Удалим его с помощью инструмента Brush (Кисть). → Mode(Режим) на панели свойств 

режим кисти – Clear (Очистить).. →. Для придания картине реалистичности на палитре 

Layers (Слои) для слоя с рыбаком значение параметра Opacity (Непрозрачность) равным 

50%. Последняя команда смягчит контраст изображения рыбака и создаст иллюзию его 

растворения в утреннем тумане. 

Открытие файла Bird.psd. → В исходном изображении птица расположена на 

однородном фоне, поэтому ее легко выбрать инструментом Волшебная палочка → Magic 

Wand (Волшебная палочка) → Select >Inverse (Выделение>Инвертировать) инвертируйте 

выделение неба, превратив его в выделение птицы. → Edit>Copy (Правка>Копирование) и 

Edit>Paste (Правка>Вставить) для размещения птицы на новом слое поверх изображения 

рыбака и ландшафта → На палитре Layers (Слои) для слоя с птицей значение параметра 

Opacity (Непрозрачность) равным 25-30% и режим наложения слоев (Set the blanding Mode 

for the layers) – Darken (Затемнение). 

4. Добавление слоя с изображением рыбы 

 
Аналогично добавлению предыдущих изображений. Особенности: фон вокруг рыбы 

можно удалить как кистью (Brush), так и ластиком Eraser. 
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Коллаж готов. В конце работы слои объединяют командой Layer>Flatten Image. 

 

Практическая работа №7 

Тема: Освоение приемов художественной обработки фотографий в программе 

Adobe Photoshop. 

Цель: работы: знакомство с основными характеристиками цифровых фильтров, 

поддерживаемых программой Adobe Photoshop, и принципами художественной обработки 

изображений на их основе; получения практических навыков по применению цифровых 

фильтров как к изображению в целом, так и к отдельным его частям. 

Исходные изображения: 

  
1. Работа со слоями, масками, наложение градиента. 

 
Layers(Слои) → Add layer mask>Reveal All (Добавить слой маску) → Gradient 

(Градиент) → Radial Gradient → Opacity (Прозрачность) 

2. Применение фильтра Radial Blur (Радиальное размытие к части изображения). 
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Layer 2>Dublicate Layer (Слой>Дублировать) → Elliptical Marquee (Эллиптическое 

выделение) → Select>Inverse (Выделение>Инверсия → Filter>Blur>Radial Blur 

(Фильтр>Размытие> Радиальное размытие) 

3. Применение фильтра «Блик» 

 
Filter>Render>Lens Flare (Фильтр>Визуализация>Блик). 
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Практическая работа №8 

Тема: Эффекты имитации Adobe Photoshop 

Цель: Научиться эффектам имитации, применение фильтров, параметры слоя, градиент, 

трансформация изображения «Рисуем космос» 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение квадратной формы: 

<="" td=""> 

Ширина: 

Высота: 400 пикселей 

Разрешение: 72 пиксели/дюйм 

Режим: RGB цвет 

Содержание (фон): Белый 

3. Инструментом Овальная область  выделите круг. 

 
4. Расположите выделение так, чтобы на изображении оказалось около четверти 

круга. 

 
5. Установитe цвета фона и переднего плана белый и чёрный 

 
6. Примените к выделенной области фильтр Облака: Фильтр ► Render ► Clouds. 

 
7. Примените к выделенной области 

фильтр Коррозия: Фильтр ► Texture ► Craquelure. 

Crack Spacing: 60 

Crack Depth: 5 

Crack Brightness: 8 

 
8. Создать объём в выделенной области фильтром Сфера Фильтр ► Distort ► 

Spherize 
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9. Раскрасьте изображение: Изображение ► Регулировки ► Цветовой балланс 

Цветовые уровни: -71, -19, +30. 

 
10. При помощи тоновых кривых, проработать каждый из цветовых каналов: Red, 

Green и Blue: 

Red Green Blue 

   

 
11. «Размойте» изображение: Фильтр ► Смазывание ► Смазывание Гаусса... 

Радиус: 0,5 пиксель. 

 
12. Создайте новый слой. 

13. В палитре градиентов создайте новый градиент, откорректировав шкалу 

цветности и прозрачности 

 
(в крайнем случае, если не получается, можно загрузить градиент с 

сервера grad403.grd) 

14. В настройках Радиального градиента установите галку в 

поле  Прозрачность и примените градиент так, чтобы получилось свечение 

атмосферы: 

 
15. Если градиент получился слишком ярким, уменьшите прозрачность слоя. 

http://www.modern-computer.ru/media/source_pictures/grad403.zip


 31 

 
16. Создате новый слой между двумя существующими. 

17. На слое с атмосферой Волшебной палочкой выделите всё, что находится за 

планетой и голубым ореолом, установив достаточно большую чувствительность. 

18. Вернитесь на новый слой. 

19. Установитe цвета фона и переднего плана чёрный __ и тёмно-синий __ 

 
20. Примените к выделенной области фильтр Облака: Фильтр ► Render ► Clouds. 

 
21. Примените к выделенной области фильтр Облака: Фильтр ► Render ► Clouds. 

 
22. При необходимости можно изменить прозрачность слоя, а так же 

яркость/контрастность. 

23. Инструментами Кисть и Аэрограф изобразите звёзды. 

 
24. Для создания кометы, не закрывая старого изображения, создайте новое 

изображение: 

Ширина: 200 пикселей 

Высота: 100 пикселей 

Разрешение: 72 пиксели/дюйм 

Режим: RGB цвет 

Содержание (фон): Черный 

 
25. Создайте белый круг. 

 
26. Примените фильтр Стекло: Фильтр ► Distort ► Glass. 

Distortion: 10 

Smoothness: 4 

Texture:  

Scaling: 100% 
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27. Для создания хвоста кометы несколько раз примените фильтр Ветер: Фильтр ► 

Stylize ► Wind... 

 
28. Ещё раз примените фильтр Стекло: Фильтр ► Distortь ► Glass. 

Distortion: 3 

Smoothness: 4 

Texture:  

Scaling: 100% 

 
29. Перейте в режим Чёрно-белый Изображение ► Режим ► Чёрно-белый 

30. Перейте в режим Индексированные цвета Изображение ► Режим ► 

Индексированные цвета 

Сопоставьте пламени цветовую модель: Изображение ► Режим ► Палитра. 

В окне Таблица цветов выберите BlackBody 

 
31. «Волшебной палочкой» с чувствительностью = 0 выделите фон. 

32. Инвертируйте выделение. 

33. Скопируйте комету в буфер обмена и вставьте на изображение с планетой. 

 
34. Измените направление полёта кометы с помощью свободного трансформирования 

Редактирование ► Произвольная трансформация 

 
35. Склейте слои. Готовое изображения сохраните в своей папке. 

Готовое изображения 
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КРИТЕРИИ БАЛЛОВ – РЕЙТИНГОВОЙ ОЦЕНКИ ЗНАНИЙ И УМЕНИЙ 

СТУДЕНТОВ 

 

 

Деятельность студентов в течение семестра оценивается следующим образом: работа 

на лекционных и практических занятиях, самостоятельные работы студентов, активность, 

посещение занятий, итоговый контроль. 

Работа на лекционных и практических занятиях 

Чтение текстов и участие в дискуссиях являются важными составляющими работы на 

лекционных и практических занятиях. Приветствуются вопросы по структуре и 

содержанию текста, комментарии, помогающие уяснить значение основных категорий и 

т.п. 

 Пропущенные занятия необходимо отработать письменно или печатном виде. 

«Отработка» должна содержать основные моменты пропущенной темы занятия. Оценка за 

«отработки» не выставляется. Последний срок сдачи «отработок» - заключительное занятие 

по курсу (тем, кто не сможет присутствовать на заключительном занятии «отработку» 

необходимо принести заранее). 

Критерии оценки: регулярное присутствие и активное участие, уместность и глубина 

вопросов и комментариев, способность задавать живой импульс дискуссии и вовлекать 

других студентов в дебаты. 

Самостоятельная работа студентов  

Самостоятельные работы выполняются на отдельном листочке письменно от руки или 

печатном виде. Указывается имя, фамилия, группа и дата сдачи работы. 

Все письменные работы НЕ принимаются позже установленных сроков сдачи, за 

исключением документально подтвержденных случаев отсутствия вследствие болезни или 

форс-мажорных обстоятельств. 

Реферативная работа оформляется письменное или печатное исполнение титульного 

листа, списка литературы, графических и табличных приложений.  

Студенты, вовремя не сдавшие реферат, защищают свою работу на консультации или 

в дополнительно отведенное время. 

Своевременное выполнение работ является предпосылкой к обоснованию 

возможности допуска студента к аттестации (экзамену). 

Проверка уровня усвоения лекционных занятий, включая теоретических СРС, 

проводится письменно, устно или тестированием по рейтинго-модульной системе.  

Результаты практических работ, включая, практических СРС принимаются в 

виде графических и контрольных работ, рефератов и собеседования.  

 

 

Система оценки знаний 

№ Этапы проверки 

Вид 

средства 

проверки 

Баллы Сроки 

1 1 модуль 

Письменный 

или 

устный 

80 

Согласно 

графику 

учебного 

процесса 

2 2 модуль 
Проверка 

заданий 
80 

Согласно 

графику 

учебного 

процесса 

3 СРС 
Контрольные 

и графические 
10 

В течение 

семестра, до 
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работы, рефераты, 

собеседование, 

презентации 

итогового 

контроля 

4 
Поощрительные 

баллы за активность 
 7 

В конце 

семестра, до 

итогового 

контроля 

5 
Посещение 

занятий 
 3 

В течение 

семестра 

6 
Итоговый 

контроль 

Письменный, 

устный или 

тестирование 
100 

Согласно 

графику 

учебного 

процесса 

 
Итого средний 

балл  
 100  

 

 

Шкала оценки знаний 

Процентное 

содержание 

(баллы) 

Цифровой 

эквивалент 

баллов 

Оценка по 

графической 

системе (по 10 

балльной 

шкале) 

Оценка по 

традиционной системе (4-х 

балльной) 

94,5-100 4,0 А 

«5» - отлично  90-94 3,67 А- 

85-89 3,33 В+ 

80-84 3,0 В 

«4» - хорошо 75-79 2,67 B- 

70-74 2,33 С+ 

65-69 2,0 С 
«3» - 

удовлетворительно 
60-64 1,67 С- 

55-59 1,33 D+ 

50-54 1,0 D 
Неудовлетворительно 

0-49 0 F 

Х Х Х 
Студент отстранен от 

дисциплины 
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Формы текущего итогового контроля 

Вопросы к экзамену 

1. Введение в компьютерную графику.  Виды компьютерной графики. 

2. Растровая графика. 

3. Векторная графика. Математические основы векторной графики. 

4. Фрактальная графика. 

5. Цветовое разрешение и цветовые модели. 

6. Форматы хранения графических изображений. 

7. Цветовая модель RGB.  

8. Цветовая модель CMYK. 

9. Цветовая модель HSB. 

10. Преобразование между цветовыми моделями. 

11. Работа с различными режимами видеоадаптера. 

12. Построение изображения двух перекрывающихся многогранников. Алгоритм 

Робертса. 

13. Пути создания реалистических изображений. 

14. Графический редактор Corel Draw. 

15. Интерфейс программы Corel Draw. Получение информации о файле. 

16. Создание нового документа в Corel Draw. Открытие и закрытие, сохранение. 

17. Инструменты для задания параметров контуров в Corel Draw. 

18. Упорядочение объектов в Corel Draw. Координатные сетки. Направляющие. 

19. Совокупности объектов в Corel Draw. Выравнивание объектов. 

20. Группировка и разгруппирование в Corel Draw.  

21. Соединение и разъединение в Corel Draw 

22. Объединение и пересечение в Corel Draw. Исключение. 

23. Интерфейс графического редактора Adobe PhotoShop. 

24. Рабочая область, стандартные элементы в Adobe PhotoShop. Открытие изображений, 

информация о документе,  

25. Палитра инструментов в Adobe PhotoShop. 

26. Работа со слоями в Adobe PhotoShop. Связывание слоев. Выравнивание слоев. 

Эффекты для слоев. 

27. Работа с текстом в Adobe PhotoShop: ввод текста, редактирование.  

28. Adobe PhotoShop . Палитра Channels, сохранение выделенной области в канале, 

дублирование и удаление каналов, редактирование каналов, сохранение выделенной 

области в другом документе. 

29. Редактирование изображений в Adobe PhotoShop. 

30. Какие виды компьютерной графики вы знаете? 

31. Какой вид компьютерной графики стоит применить для разработки эмблемы 

предприятия, если заранее известно, что размер эмблемы может быть как малым (на 

бланках предприятия), так и большим (на рекламных плакатах или па футболках и 

других сувенирных изделиях)? 

32. Какой   виды компьютерной   графики стоит применить для обработки цветной 

фотографии, предназначенной для рекламного буклета? 

33. В каких единицах измеряют размеры экранных изображений и печатных 

изображений? 

34. В каких единицах измеряют: разрешение экрана, разрешение принтера, разрешение 

изображения? 

35. Назовите наименьший элемент растрового изображения? 

36. Назовите наименьший элемент векторного изображения?  

37. В результате каких операций можно получить сложный объект?  

38. Какие операции можно провести над группой объектов? 
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39. С помощью каких операций можно модифицировать (изменить) форму простейших 

объектов? 

40. В чем принципиальное отличие простого и художественного текста? Дайте краткие 

характеристики типов текста. 

41. Какие типы заливки CorelDraw Вы знаете? Назовите их параметры и эффекты, 

создаваемые с их помощью. 

42. Как можно осуществить просмотр и выбор цвета в CorelDraw? 

43. Назовите основные средства преобразования и управления позиционированием 

объектов. 

44. С помощью каких средств можно определить положение и измерить размер 

объектов на странице? 

45. Трехмерная графика 

46. Этапы построения трехмерных объектов 

47. История развития трехмерной графики 
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ТЕМЫ СРС ПО ДИСЦИПЛИНЕ 

СРС (2 ч.) Проекции. Получение проекций с использованием матриц 

СРС (1 ч.) Подготовка доклада по теме: Матричное представление трехмерных 

преобразований 

СРС (1ч.) Подготовка презентации: Методы закраски 

СРС (1ч.) Подготовка рефератов по теме: Архитектура графических станций. 

Видеоконтроллеры и графические ускорители 

СРС (1ч.) Записывать ключевые слова  

СРС (1ч.) Основы 3D графики 

СРС (1ч.) Подготовка доклада по теме: Виртуальная реальность 

СРС (1ч.) Оформление мультимедийной презентации по теме: Аппаратная поддержка 

3D графики 

СРС (1ч.) Подготовить сообщения по теме: Векторизаторы. Алгоритмы векторизации 

СРС (1ч.) Подготовка к практическим занятиям 

СРС (1ч.) Подготовка к практическим занятиям 

СРС (1ч.) Подготовка к практическим занятиям 

СРС (1ч.) Получить справочную информацию по интересующему Вас вопросу. 

СРС (1ч.) Подготовка к практическим занятиям 

СРС (1ч.) Подготовить сообщения по теме: Сочетание цветов в Web-дизайне 

СРС (1ч.) Подготовка к практическим занятиям 

СРС (1ч.) Подготовить сообщения по теме: Графическая библиотека OpenGL 

СРС (1ч.) Подготовка к практическим занятиям 

СРС (1ч.) Подготовка к практическим занятиям 

СРС (1ч.) Получить справочную информацию по интересующему Вас вопросу. 

СРС (1ч.) Подготовка к практическим занятиям 

СРС (1ч.) Подготовка к практическим занятиям 

 

ТЕМЫ СРС 

1. Векторные редакторы 

2. Растровые редакторы 

3. Создание анимированных сцен 

4. Средства 3D графики 

5. Настольные издательские системы 

6. Векторизаторы. Алгоритмы векторизации 

7. Программное обеспечение компьютерной графики 

8. Сочетание цветов в Web-дизайне 

9. Двумерные преобразования 

10. Однородные координаты и матричное представление двумерных преобразований 

11. Проекции. Получение проекций с использованием матриц 

12. Матричное представление трехмерных преобразований 

13. Полигональные модели 

14. Параметрические кубические кривые и поверхности 

15. Тени, поверхности пропускающие цвет, детализация поверхности 

16. Закраска области заданной цветом границы 

17. Отсечение многоугольников 

18. Заполнение многоугольников 

19. Стандарт DirectX 

20. Графическая библиотека OpenGL 

21. Архитектура графических станций 

22. Видеоконтроллеры и графические ускорители 

23. Обзор программного обеспечения компьютерной графики 
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24. Аппаратная поддержка 3D графики 

25. Сравнение OpenGL и Direct3D 

26. Основы 3D графики 

27. Виртуальная реальность 

28. Построение реалистичных трехмерных сцен 
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Тестовый контроль 

1.  

Минимальным объектом, 

используемым в векторном 

графическом редакторе, является ...  

(в)   

а) точка экрана (пиксель) 

б) объект (прямоугольник, круг и т. д.) 

в) палитра цветов 

г) знакоместо (символ) 

2.  

Примитивами в графическом 

редакторе называются ...  

(а) 

а) линия, круг, прямоугольник 

б) карандаш, кисть, ластик 

в) выделение, копирование, вставка 

г) наборы цветов (палитра) 

3.  

Система RGB служит для 

кодирования... 

(в) 

а) текстовой информации 

б) числовой информации 

в) графической информации 

г) звуковой информации 

4.  

Разрешение изображения измеряется 

в ... 

(а) 

а) пикселах 

б) точках на дюйм (dpi) 

в) мм, см, дюймах 

5.  

В модели CMYK в качестве 

компонентов применяются основные 

цвета ... 

(б) 

а) красный, зеленый, синий, черный 

б) голубой, пурпурный, желтый, черный 

в) красный, голубой, желтый, синий 

г) голубой, пурпурный, желтый, белый 

6.  

Минимальным объектом, 

используемым в растровом 

графическом редакторе, является ... 

(а) 

а) точка экрана (пиксель) 

б) объект (прямоугольник, круг и т.д.) 

в) палитра цветов 

г) знакоместо (символ) 

7.  

Деформация изображения при 

изменении размера рисунка - один из 

недостатков ... 

(б) 

а) векторной графики 

б) растровой графики 

в) фрактальной графики 

8.  

В модели RGB в качестве 

компонентов применяются основные 

цвета ...  

(а) 

а) красный, зеленый, синий 

б) голубой, пурпурный, желтый 

в) красный, голубой, желтый 

г) пурпурный, желтый, черный 

9.  

Большой размер файла - один из 

недостатков ...  

(а) 

а) растровой графики 

б) векторной графики 

в) фрактальной графики 

10.  Графическим редактором 

называется программа, 

предназначенная для ...  

(в) 

а) создания графического образа текста 

б) редактирования вида и начертания 

шрифта 

в) работы с графическим изображением 

г) построения диаграмм 

11.  Какие из графических редакторов 

являются векторными? 

(в) 

А)Adobe Photoshop 

Б)Corel Draw 

В)Paint 

12.  Какой вид графики обладает более 

высокой точностью передачи 

градаций цветов и полутонов 

(а) 

а) Растровая графика 

б) Векторная графика 

в) Оба вида 

13.  Если элементов графического 

изображения много и нам нужно их 

все переместить, нам на помощь 

приходит... 

а)Группировка 

б)Объединение 

в)Слияние 
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Выберите один из вариантов ответа: 

(а) 

14.  Укажите формат, не являющийся 

графическим: 

(в) 

 

а)BMP  

б)GIF  

в)COM  

г)JPG 

15.  Пиксели на экране образуют сетку из 

горизонтальных и вертикальных 

столбцов, которую называют: (г) 

а)координатная плоскость 

б)видеопамять 

в)растр 

г)матрица 
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СПИСОК ОСНОВНОЙ И ДОПОЛНИТЕЛЬНОЙ ЛИТЕРАТУРЫ  

№ 

Библиографическое 

описание издания (автор, 

наименование, вид, место и 

год издания, кол.стр.) 

Виды занятия 

в котором 

используется 

Кол-во экз. в 

библиотеке 

университета 

примечание 

Основная литература 

1 Аверин, В.Н. Компьютерная 

графика: Учебник / В.Н. 

Аверин. - М.: Academia, 

2016.  

Лекция 

1  

2 Аверин, В.Н. Компьютерная 

инженерная графика: 

Учебное пособие / В.Н. 

Аверин. - М.: Academia, 

2019. 

Лекция 

1  

3 Инженерная и компьютерная 

графика: Учебник / В.М. 

Дегтярев. - М.: Academia, 

2011. 

Лекция 

2  

Дополнительная литература 

1 Компьютерная графика и 

дизайн: Учебник / В.Т. 

Тозик. - М.: Академия, 2009. 

Лекция 

1  
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Глоссарий 

Двумерная графика - графика, *действие* в которой происходит в одной плоскости. 

Например пользовательский интерфейс. 

Трехмерная графика - визуальное отображение трехмерной сцены или объекта. Для 

представления трехмерной графике на двумерном устройстве (дисплей) применяют 

рендеринг (см. Rendering). 

Atmospheric Effect - Специальные эффекты, например туман, позволяющие улучшить 

рендеринг изображений реального мира. 

Вторичный буфер - область памяти, в которой рассчитываются объекты трехмерной 

сцены. Вывод изображения на экран осуществляется через Front Buffer (первичный буфер). 

Обычно процесс копирования содержимого вторичного буфера синхронизируется с 

обратным ходом луча ЭЛТ монитора. Таким образом достигается плавная смена кадров. 

Bitmap - Способ кодирования изображения пиксел за пикселом. 

Bilinear (bi-linear) Filtering - метод устранения искажений изображения (устранение 

"блочности" текстур при их увеличении). При медленном вращении или движении объекта 

(приближение/удаление) могут быть заметны перескакивания пикселов с одного места на 

другое, т.е. появляется блочность. Для снижения этого эффекта при билинейной 

фильтрации берется взвешенное среднее значение цвета четырех смежных текстурных 

пикселов (texels) и в результате определяется цвет текстуры. 

Блендинг - комбинирование двух или более объектов с использованием некоторого базиса 

пикселов. 

Буфер -  область временного хранения данных, часто используется для компенсации 

разницы в скорости работы различных компонентов системы. Часто, в качестве буфера 

используется дополнительная память, зарезервированная для временного хранения данных, 

которые передаются между центральным процессором системы и периферией (такой, как 

винчестер, принтер или видеоадаптером). Особенно полезен буфер для компенсации 

разницы в уровнях интенсивности потоков данных, для обеспечения места размещения 

данных, когда процессы асинхронны (например, данные переданные в контроллер 

видеоплаты должны дождаться, когда графический процессор закончит выполнение 

текущей операции, и считает новую порцию информации), и для сохранения данных в 

неизменном виде (как буфер для видеокадра). Некоторые буферы являются частью 

адресуемой памяти центрального процессора системы, другие буферы памяти являются 

частью периферийных устройсв.  

Цветовое освещение - освещение источниками разного цвета, при этом происходит 

смешение цвета. Совсем недавно цветовое освещение стало использоваться в новейших 3D 

играх (Quake2, Unreal, Prey, Half Life). 

Компьютерная графика - общее направление, описывающее создание или манипуляцию 

графическими изображениями и изобразительными данными с помощью компьютера. 

Может использоваться в CAD, анимации, дизайне, архитектуре, деловой графике и т.д. 

Системы для компьтерной графики обычно являются интерактивными, т.е. отображают 

изображение на дисплее таким, каким оно создано, или в виде, в который преобразована 

исходная картинка. 

Depth Cueing - уменьшение интенсивности освещения текстур при удалении объекта от 

точки наблюдения. 

Directional - световой источник, который освещает одинаково все объекты сцены, как бы 

из бесконечности в определенном направлении. Обычно используется для создания 

удаленных световых источников (таких как Солнце). 

Dithering - способ получения изображения 24-битного качества с использованием 8- или 

16-битных буферов. Два цвета используются для моделирования третьего, и 

обеспечиваются плавные переходы между элементами изображения. 



 43 

Fogging – Затуманивание - образуется за счет комбинирования смешанных компьютерных 

цветовых пикселов с цветом тумана (fog) под управлением функции, определяющей 

глубину затуманивания. 

Интерактивнось  - этим термином описывается поведение прикладной программы, с 

помощью которой пользователь может влиять на результат деятельности приложения, имея 

возможность немедленно добавить, изменить, или удалить получающийся результат. 

Lighting  - Существуют разные методы, использующие реалистичные графические 

эффекты, для отображения 3D объектов на двумерном дисплее. Один из них - освещение. 

Используются разные уровни яркости (светло-темно) при отображении объекта для 

придания ему объема. 

Occlusion - Эффект перекрытия в трехмерном пространстве одного объекта другим. 

Пиксель - комбинированный термин, обозначающий элемент изображения, являющийся 

наименьшим элементом экрана монитора. Другое название - pel. 

Изображение на экране состоят из сотен тысяч пикселей, объединенных для формирования 

изображения. Пиксель является минимальным сегментом растровой строки, которая 

дискретно управляется системой, образующей изображение. С другой стороны, это 

координата, используемая для определения горизонтальной пространственной позиции 

пикселя в пределах изображения. Пиксели на мониторе - это светящиеся точки яркого 

фосфора, являющиеся минимальным элементом цифрового изображения. Размер пикселя 

не может быть меньше точки, которую монитор может образовать. На цветном мониторе 

точки состоят из групп триад. Триады формируются тремя различными фосфорами: 

красным, зеленым и синим. Фосфоры располагаются вдоль сторон друг друга. Пиксели 

могут отличаться размерами и формой, в зависимости от монитора и графического режима. 

Количество точек на экране определяются физическим соотношением ширины к высоте 

трубки. 

Point - световой источник, который светит одинаково во всех направлениях из одной точки 

(например лампочка в комнате). 

Ray Tracing - "Трассировка лучей" - один из самых сложных и качественных методов 

построения реалистических изображений. Наиболее распространен вариант "обратной 

трассировки лучей": от глаза наблюдателя, через пиксел строящегося изображения, 

проводят луч и, учитывая все его отражения от объектов, вычисляют цвет этого пиксела. 

RGB - Система цветообразования, в которой конечный цвет получается за счет смешения, 

с различной интенсивностью, трех основных цветов: красного (Red), зеленого (Green) и 

синего (Blue). Самое известное устройство, которое использует систему RGB, это цветной 

монитор. 

Real-time - режим реального времени, при этом иммитируемые события происходят так же, 

как и в реальной жизни. Для достижения этого используется синхронизация со встроенным 

таймером компьютера. 

Rendering - процесс создания реалистичных изображений на эране, использующий 

математические модели и формулы для добавления цвета, тени и т.д. 

Rendering Engine - дословно - устройство рендеринга. Часть графической системы, которая 

рисует 3D- примитивы, такие как треугольники или другие простые многоугольники. 

Практически во всех реализациях системы rendering engine отвечает за интерполяцию краев 

(границ) объектов и заполнение пикселами многоугольников. 

Resolution – Разрешение -  количество пикселей представленное битами в видеопамяти, 

или адресуемое разрешение. Видеопамять может организовываться соотношением 

пикселов (битов) по оси x (пикселы на строке) к числу пикселов по оси y (столбцы) и к 

размеру отводимой памяти на представление глубины цвета. Стандартная видеопамять 

VGA 640 пикселов на 480 пикселов и, обычно, с глубиной представления цвета 8 бит. Чем 

выше разрешение, тем более детально изображение, тем больше нужно хранить о нем 

информации. Но не вся хранимая информация может быть отображена на дисплее. 
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Texture - двумерное изображение хранящееся в памяти компьютера или графического 

акселератора в одном из пиксельных форматов. В случае хранения в сжатом виде на дисках 

компьютера, текстура может представлят собой обычный бит-мап который мы привыкли 

видеть в форматах bmp, jpg, gif и т.д. Перед использованием, текстура разворачивается в 

памяти и может занимать объем в десятки раз больше первоначального размера. 

Существует порядка двух десятков более или менее стандартизированных пиксельных 

форматов текстур.  

Transformation - изменение координат. Последовательность математических операций 

над выходными графическими примитивами и геометрическими атрибутами, для 

преобразования их из рассчетных координат в системные координаты. 

Transparency - прозрачность. В компьютерной графике цвет часто описывается в 

терминах RGB величин, или величинами красного, зеленого и синиго цвета. Существует 

еще коэффициент Alpha (альфа), являющийся дополнительным компонентом цвета, 

который используется для смешения. Коэффициент Alpha может также использоваться в 

качестве величины, отвечающей за степень прозрачности, т.е. величины, определяющей 

можно ли видеть сквозь цвет или нет. Наиболее важное значение коэффициент Alpha, или 

прозрачность, имеет в 3D графике, благодаря его использованию для создания 

нерегулярных объектов, применяя для этого лишь несколько многоугольников. 

 

 


